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Abstract

The result of a measurement with the TANSY neutron spectrometer is stored
in two list mode files. The files are divided into three parts, a header containing the
parameters for the measurement, a data area containing the amplitude calibration data,
and a body containing the measured data in list mode.

The purpose of this program is the evaluation of the data for inspection and re-
calibration of the instrument. Several options are included for investigation of as many
of the properties of the instrument as possible.

The program can also be used for the final evaluation and the presentation of
the neutron spectra. However, the intention is this should be done using SNAP, the
general evaluation program for JET, written by Pieter van Belle. A spin-off of the
program is that it is used as a support for the writing of the routines included in SNAP.

The final result of the program is a neutron spectrum. Weight factors for the
energy dependent sensitivity of the instrument are included. However, enhancement of
the resolution using the response functions are not included and no routines are
included for the evaluation of plasma parameters.

This document is a complement to the help files delivered with the program.
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1. Introduction
The neutron spectrometer TANSY is a complicated instrument and must be carefully
calibrated to give relevant data. However, tests at the Department of Reactor Physics
at Chalmers University of Technology and the experiences of the first measurements at
JET have proved that very good and stable results can be achieved after the calibration
of the instrument.

The instrument was first taken into operation at JET during the spring of 1997.
Simultaneously the final parts of this program were written and used.

The calibration of the different parts of the instrument is done separately. A set
of programs have previously been written and used for that purpose. The amplitudes of
the pulses from the six proton detectors are calibrated using the included Am-sources
and a high quality pulse generator. For the time synchronisation of the 32 neutron
detectors we use a Cobalt-source. However, inherent in the data taken during a
measurement lies a possibility to do a final adjustment including all parts of the
instrument. This possibility has been explored and used in this program.

The data from a measurement may be fetched directly from the instrument.
However, as the data now is included in the Codas JPF file it is better to take the data
from there. A special routine has been included in SNAP to convert the files to a form
suitable for this PC based program. The files are converted by SNAP and transferred to
the PC using binary transfer.

A special program has been written to digitally inspect the data in the file. That
program, called PRINT EVENTS, is installed in the computer at the instrument. It is
left there as it is and no installation diskettes are delivered. A similar routine is written
by Pieter van Belle and included in SNAP.

Some new options have been included in the previously delivered programs.
The parameter program PARA can now read the parameters from the measurement
files. The program AMSHOW has got a routine to read and investigate the stored
amplitudes.
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2. The Installation of Sort
Click on setup.exe to install the program. An icon will be created in the program
manager for SORT. Two help files are delivered with the program, one for SORT,
Sort.hlp, and one for the Graphic Server, graphppr.hlp. They can be reached from the
program. Context related help is included. However, if you want to have icons for the
help files in the program manager you have to create them manually. Most of the
information in this document can be found in the Sort help file.

The program will use about 7 MB of disk space.

The program uses an ".INI" file that is created the first time you use it. The file
contains the selection of the detectors and the time intervals. Note that no detector and
no time interval are selected the first time you use the program.

Two input files are included in the installation. The first is the result of the JET
shot 41600. At that time the fine adjustment was not done so you should go through
the time calibration to get good results. The second one, 41760, is a measurement
done after the fine adjustment. No further calibration is needed. In both cases you
should use the "new" values for the amplitude calibration.

TANSY - 5 - - KM5
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3. The evaluation using the program Sort
Sort is a program for the investigation of the data from a measurement using the
TANSY neutron spectrometer. The data are stored in two files, one for each of the
two branches. It contains parameters defining the set-up used, calibration data, and the
measured data stored in a list. Each item in the list can be a true event, an erroneous
event, or a time identification event. The purpose of this program is to sort the true
events into histograms. Several types of histograms are included for the investigation
of the behaviour of the instrument.

Another available option is the time-calibration of the neutron flight time. Inter-
calibration of the neutron detector timing is done prior to the measurement. However,
calibration of the timing of the proton-detectors can only be approximately done. Here
we use the intrinsic properties of the instrument to fine-adjust the timing of the proton-
detectors.

The program is normally used as follows:

1) Open the measurement files, extensions .MEA or .MEB. One or two files can be
opened simultaneously.

2) Select the real time intervals, proton detectors, and neutron-detectors to be included
in the analysis.

3) Sort the events into two- or three-dimensional histograms.
4) View and analyse the histograms using the available tools.

The resulting distributions may be stored and added to the distributions obtained from
similar measurements.

TANSY - 6 ~ KM5
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4. The Main Menu

Only File and Help are available when no file is open. Use the File menu to open new files.

4.1. The File Menu

Close Input File
Import or Export Parameters

Click on Open Input File for new input files. Only one
set of files, normally one for each branch can be used at
the same time. Use Close Input File to clean up the data
areas for a new file and Exit to quit.

Open Input File loads the file selection form:

# Branch A

O Braacfe 8

d:\tansyeva\.data\p341.mea

d:\tansjieva\dalaSp341.meb

Od:[0UDMARAPPL]

".MEA

p341..mea.
p344_mea
H.mea

Select the directory (1).
Click on the file name
(2). The full path is
inserted in the file
name box (3), and the
option is shifted to the
other branch (4). Click
on the file name for the
other branch (2) to get
the second file name.
The files presented in
the file name box (3) at
the time you click the
open button (6) will be
used for the analysis.

You may use the
option buttons (4) to

manually shift between the two input files. The available filters (5) are .MEA, .MEB, and .ME*.

Cascel Open

TANSY KM5
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Scan dlfoaftsyeya|1tl3la\p34'Lmea

Number of Events = 83338
Number of True Events = 73616
Number of False Events = 6842
Number of Time Markers = 2880

;<ac

A click on the Open button loads the files
into the memory. They are scanned for
references to the different time intervals
(not shown) and the number of found
events are shown to the user. This is a
validity test of the files. An error message
is given if non-consistent data are found.
Time markers are necessary for the
following analysis. In a test case with less
than 100 time markers fictive markers are
inserted. They are distributed evenly in
the list data areas.

The parameters used during the analysis
are normally fetched from the header of
the data file. However, these may not be
correct. The instrument may have been

re-calibrated at some later time giving more appropriate values of the parameters. A menu item
Import or Export Parameters, visible after the opening of the files, gives the user a possibility to
correct these values.

The file format is the same as the one used in the PARA program. This latter program can be used to
create an input file. Selection of parameters can be done using the menu shown below. Options are
available for energy and time calibration parameter values. Further selection can be done by editing
the input file using e. g. notepad.
Note that the import must be done after the reading of the main input file and that the calibration
options alter the calibration parameters back to the header values of this file. Avoid time calibration
and use cancel in the energy calibration routines to keep the imported values.

Save as stores the parameters in a new file that can be imported to the program PARA or edited by
notepad.

Detector Parameters

f " Default Energy Calibration

Protoft Time Caiibiation

f~ Neutroo Time Calibration

ions
C M in Fite

TANSY - 8 - KM5



Sort

4.2. The Select Menu

Select Neutron Detectors
Select Proton Detectors

The Select Menu is used to select the time intervals, neutron
detectors, and proton detectors to be included in the analysis.
At exit the values are stored in the Sort INI-file and recovered
at a new start of the program.

4.2.1. Select Time Intervals

Time interval markers are inserted in the list file by the CPG3 module. Timing normally starts at 35
seconds and 2000 markers are inserted, one every 25 millisecond. With Select Time Intervals you
make up to 16 time groups out of the intervals defined in the file.

The groups are labelled A, B, C, and so on. The groups are used in all the Sort options. The last
MMMHMMJsaaaraam^wMiBMw—B* option, Neutron Energy and Time, is special because equal time

intervals are needed. In this case the length of the first interval
is used for all intervals regardless of the settings of the other
intervals.0
The form contains three main items:
1) A graph showing the number of events as a function of time
and the inserted groups,
2) Command buttons for the groups together with the start time
of the groups,
3) Some command buttons and text boxes for the start time and

the time interval.

You add a new group using the following sequence:

1) Click on the last group button
2) Move the cursor to the graph and press the mouse button. A marker line is shown in the graph.
3) While the mouse button is pressed you can move the line to the wanted position
4) Release the mouse button and click on the command button Draw Timeintervals to refresh the
diagram.

The position of a time limit may be changed at any time by clicking the respective button and
repeating the above sequence from item 2.

TANSY KM5
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4.2.1.1 .The command buttons

Use the option buttons Select/Deselect to select or to deselect an

interval. The icon . » appears when the cursor is over the interval

buttons for select and the icon a appears for deselect. Click on the
interval buttons to select or deselect an interval.
Undo All resets all intervals.
Log/Lin changes the graph to logarithmic or linear scale.
Draw Timeintervals refreshes the graph.
Cancel leaves the routine with unaltered intervals.
Done inserts the new intervals.

Selecf P

Undo MS Log/Lin;

Dtaw Timeintervals

Cancel s Done

4.2.1.2/The Menu

A Repeat Last Region
Remove Last Region

You may use the Zooming menu for fine adjustments
of the interval limits using the same procedure as
above. However, another option is included in the
Tools menu. The Fine Adjust creates spin buttons for
the fine adjustment.

0
Click on the Fine Adjust menu to make the spin buttons visible. Then click an

interval button to activate a time limit and use the buttons to fine adjust the
limit. Repeat for any time limit. Click the Fine Adjust menu again to remove
the spin buttons.

Often you use the same interval length for several intervals. A click on Repeat
Last Region adds a new region with the same length as the previous one.

Delete the last region using the Remove Last Region menu. Note that the Undo All button removes all
intervals to enable a fresh start.

TANSY --10- KM5
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4.2.2. Select Neutron and Proton Detectors

4.2.2.1 .Neutron Detectors

Click on the detector signals to select or deselect the detectors.

t) .indicates a selected detector and

^ ^ indicates a detector not selected.

Use button Branch B to select or deselect detectors from the other branch.
Use button Select All to select all the detectors in the viewed branch.
Use button Deselect All to deselect all the detectors in the viewed branch.
Use button Done to leave the routine and store the new settings.
Use button Cancel to leave the routine and keep the old settings.
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4.2.2.2.Proton Detectors

ancfh •*:mii.

All the proton detectors are viewed in one form. The buttons have the same functions as the neutron-
detector buttons.

Click on the detector signals to select or deselect the detectors.

"-"' indicates a selected detector and

^ indicates a detector not selected.

Use button Branch B to select or deselect detectors from the other branch.
Use button Select All to select all the detectors in the viewed branch.
Use button Deselect All to deselect all the detectors in the viewed branch.
Use button Done to leave the routine and store the new settings.
Use button Cancel to leave the routine and keep the old settings.
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4.3. Two Dimensional Histograms

-3D Calibrate Help

Amplitudes vs Proton Detector

Flight-Time vs Time
Flight-Time vs Neutron Detector
Flight-Time vs Branch

Neutron Energy vs Time
Neutron Energy vs Proton Detector
Neutron Energy vs Branch

Geometric Factor vs Time
Geometric Factor vs Proton Detector
Geometric Factor vs Branch and Group

Check Time Calibration

Amplitudes vs. Time (ATI1)
gives the amplitude distributions for the
groups defined by select,

Amplitude vs. Proton Detector
(APR) gives the amplitude distributions
for all defined proton detectors
summed over all groups,

Flight-Time vs. Time (TTI)
gives the Flight-Time distributions for
the groups defined by select,

Flight-Time vs. Neutron
Detector (TNE) gives the Flight-Time
distributions for all defined neutron
detectors summed over all defined
groups,

Flight-Time vs. Branch (TBR) gives the Flight-Time distributions for both
branches summed over all selected neutron detectors and groups,

Neutron Energy vs. Time (NET)gives the neutron energy distributions for the
groups defined by select,

Neutron Energy vs. Proton Detector (NEP) gives the neutron energy
distributions for all defined proton detectors summed over all groups,

Neutron Energy vs. Branch (NEB) gives the neutron energy distribution for
both branches summed over all selected neutron detectors and groups,

Geometric Factor vs. Time (GFT) gives the geometric factor for the groups
defined by select,

Geometric Factor vs. Proton Detector (GFP) .gives the geometric factor
distributions for all defined proton detectors summed over all groups,

Geometric Factor vs. Branch (GFB) gives the neutron geometric factor for
both branches summed over all selected detectors in the groups of the lower and upper
neutron detectors,

Check Time Calibration (TRC) is a test of the time calibration of each neutron
detector. See Time Calibration for details.

1 The letters given inside the parentheses represent the three letter abbreviation used to indicate the
type of graph.
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4.3.1. Amplitude Distributions

The amplitude distributions give information about the status of the proton
detectors and associated electronics. The resolution of the proton detectors is
investigated using the amplitude distributions obtained between the pulses. They can be
viewed using the AmShow program. Here we get information about the behaviour
during the shot. Any malfunction of the detectors, the amplifiers, and the
discriminators is shown in the graphs.

In the first graph, ATI, the distributions labelled A, B, and C show the
histograms for the selected time intei'vals. All selected proton detectors are included.

5

c

..afciafa\p341-AmSSSSS& SS

AmptHeds ¥s Proton Sat

: 1 '" \ ^
ft viii i<w» -i«Ji *»* His 't tit ?i>* *Wz

AB

BO
Bt
B2

In the second one, APR, all selected time intervals are included. It is used to
investigate the separate proton detectors as indicated in the legend.
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4.3.2. Flight Time Distributions

The timing for the measurement of the flight time of the scattered neutrons is
important. The selection of the time interval is done in two steps. The first uses the
hardware to do a first selection of the time interval of interest. Events outside this
interval are ignored. The second is a software selection done by the Starburst data
taking routine. Only events inside the software time limits are recorded in the list mode
data. The three flight-time distribution options are included to check the timing of the
neutron events and the settings of these limits.

iiiiilHiliilii

The first graph, TTI, shows the flight-time distributions for the selected time
intervals.

: 19

5

5? « %£ i&

4 rTNE SS v 1 *:

The second one, TNE, gives one distribution for each neutron detector. All
events for all selected time intervals are included. When the graph is enlarged a legend
will be shown indicating the different neutron detectors.

«*LaWa*p341-T8RSS

15*

ftk

/ A |;

e h

The third graph, TBR, shows the flight-time distributions for the two branches.
Here the user has two options. He may choose to include the time delays given in the
parameter list or to exclude them. The first one, the synchronised option, is valuable
for the study of the timing as it will be used later for the neutron energy calculations;
the second one, the not synchronised option is valuable for the study of the behaviour
of the hardware.

TANSY -15- KM5
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4.3.3. Neutron Energy distributions

The neutron energy distributions show the final result of the measurement. The
data are corrected for the foil thickness but the response functions are not taken into
account.

Three options are available.

«*

The first one, NET, gives the total result, one distribution for each selected
time interval summed over all selected proton and neutron detectors. Note that the
lowest time interval setting is given by the time markers. At JET normally 2000 time
markers are used, which gives a time resolution of 25 milliseconds.

|p tp f l l l

111

•
In the second one, NEP, the events are sorted according to the proton detector;

and in the third one, NEB, the events are sorted according to the branch. In the
second and third cases all selected time intervals are included.

TANSY -16-- KM5
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4.3.4. Geometric Factor Distributions

The geometric factor is a special feature of the instrument. It has been shown
that it is independent of the incoming neutron energy. It depends only on the geometric
configuration of the foil and the detectors. Therefore, it is a very valuable tool for the
investigation of the behaviour of the instrument. As a special feature it can be used to
fine calibrate the timing of the flight-time measurement of the scattered neutrons. Here
is given an opportunity to study the shape of the geometric factor.

The first graph, GFT, gives the geometric factor sorted according to the
selected time intervals. The events from all selected detectors are included.

In the second, GFP, all events in all selected time intervals are sorted according
to the proton detector.

The geometric factor depends on the scattering angle. As this is very different
for the upper and lower row of neutron detectors the last graph, GFB, shows the
events sorted according to the branch and the row of detectors. The upper rows have
shorter time of flights and accordingly the mean value of the geometric factor is higher
than the one for the lower row.

TANSY - 1 7 . . KM5
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4.3.5. A Check of the Time Calibration

The geometric factor can be used to
check the time calibration of the detectors. It is
done for the proton detector lines as described in
the time calibration chapter. The graph TRC is a
tool to check the individual neutron detectors.
The peaks of the distributions should be at 160
ns. The shift is included to be able to plot

negative time deviations. Events from all selected intervals are included.

4.4. Three Dimensional Histograms

Proton Energy and Flight-Time
Neutron Energy and Geometric Factor

Four display options are
available to give an overview of the
data. In all cases a 256*256 matrix is
used to store the data. However, they
are compressed on the display to fit into
the capacity of the display area. The

tools described later in this document can be used to enhance the presentation and
zoom in to the relevant part of the data.

Neutron Energy and Time

4.4.1. The Amplitude and Flight-Time Distribution

flight-time interval number.

The amplitude and flight-time
distribution, AT3, gives an overview of the
measured amplitudes and correlated neutron
flight-times. A peaked neutron distribution
as the one obtained using the neutron
generator gives a banana-Like distribution.
Short flight times correspond to low
amplitudes. The data area is cut by the
discriminators and the software time
settings. It is a tool to see the combined
effect of these.

The numbered axis represents the

TANSY -18- KM5
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4.4.2. The Proton-Energy and Flight-Time Distribution

In the proton-energy and flight-time
distribution, P3T, the amplitudes are
converted into proton energies and presented
together with the corresponding neutron
flight times. The shape of the distribution
should be approximately the same as in the
unconverted distribution. It is the first
intermediate step against the final neutron
distribution.

The numbered axis represents the
flight-time interval number.

4.4.3. The Neutron-Energy and Geometric Factor Distribution

The neutron-energy and
geometric-factor distribution, N3G, is
the second intermediate step against a
neutron distribution. The neutron
energy and the geometric factor are
independent The shape of the
geometric factor should be the same for
all neutron energies and, therefore, the
remaining operation for a final neutron
spectrum is to sum the data over all
values of the geometric factor. The
graph shows a field of neutron energies

with a mean value parallel to the axis of the geometric factor.
The numbered axis represents the interval number of the geometric factor.

TANSY -19-- KM5
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4.4.4. The Neutron-Energy and Time Distribution

The neutron energy and time distribution,
N3T, is the final distribution as function of real
time and neutron energy. The time intervals are
equal and taken from the first interval in the time
selection, interval "A". Normally, only a small
part of the 256*256 matrix is filled with data. The
Zoom option is used to display the intervals of
interest.

The numbered axis represents the time
interval number starting at the time interval
defined by the zooming.

5. Calibrations

Calibrate Time Scale

TANSY uses proton detectors to measure the
energy of the recoiling proton, and neutron detectors
to measure the time-of-flight of the scattered

neutrons. Both these measurements must be calibrated. Most of this work is done prior
to the measurement. For the energy calibration we use an Am source and a precision
pulse generator. For the time calibration we use a cobalt source. Two separate
programs are used for that purpose, Amcal for the energy calibration and Timcal for
the time calibration. The result of these calibration measurements are stored in the
header of the measurement file. However, the final fine adjustments and the corrections
for the long time variations of the calibration parameters must be done using the
neutrons. Fortunately, the measurement itself contains elements that can be used for re-
calibration of the instrument.

The re-calibration of the energy scale can be done using the menu item
Calibrate Energy Scale and the re-calibration of the time can be done using the menu
item Calibrate Flight Time.

TANSY - 2 0 - KM5
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5.1. The Proton Energy Calibration

Default

Base. ReY

| mas

keWC§»«nnel

2/55 I
£6483 |

mm*
3a$g, ReV
-4.56

; -3G.39

-15.50

keV/Cbawje?
2.6697

2.5487

2.6454

Branch B'

Set All Default

Defetilt

Base, keV

32.34

\ 32.22

ke^

2.5383

£82*7 !!
2.593 |

Base,

33.9G

!-0.71

35.48

keV

t

keV/Chatnnet

2.5314

2.G2G9

2.5971

Use

Daftauft

Cancel

The Energy Calibration Form is the tool used to calibrate the energy scale. As a
user you have to use either the default values, the values created during the calibration
prior to the measurement, or the new values, the values calculated from the
measurements done between the shots.

I!

1
2

-Z23
; -36.68

Z.6836
2.55

zmm

The default values are the offset
(Base) and the amplification factor
(keV/Channel) created during the calibration
using the program "Amcal". Use these if the
new values are unreliable.

New

3ase, keV
-4.5G

-36.39

-15.50

i keV^Cfranne

2.GG97

2.5487

2.G454

I
The energy of the Am- and the pulse-

generator peak are stored in the file header. The
pulse distribution for these peaks is measured
between the shots in a Starburst area that is stored
in the JPF file. The values are divided by two at the
overflow of any of the 16-bit words used in the

TANSY - 2 1 - KM5
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area. New values are calculated from these distributions. It is assumed that the pulse
generator peak is stable.

User instructions:
Use

Click on New or Default to choose one of the options for one of Default
the detectors. | s | e w

to change all the options to NewUse

and wMmM$mM»Mmm£ma to change all options to Default-

CancelI Done 1 • I
Use I •. •.•••"" «••! to activate your selection or I to ignore it.

Calibrate Time Scale

5.2. The Calibration of the Time Measurement
Hidden in the list mode data is information about not

only the flight times of the scattered neutrons but also
information that can be used for the calibration of the
measured flight times.

The time calibration method is based on the formulae given in reference 2, page
73. The geometric factor in eq. 7.1 of that report is independent of the neutron energy.
We use the time calculated from the geometric factor to determine the flight times. A
correlation between a gaussian distribution and the calculated flight time distribution is
used for the calibration. However the distribution is not evenly centred around the
detector points used. Experimentally it is found that a correction of 3.2 ns is needed to
get correct values.

The procedure to explore this using "Sort" is as follows:

1) Click on the menu Calibrate Time Scale.
The data are sorted on a time scale.

TANSY --22-- KM5
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2) Zoom to an area covering the peaks close to the centre of the diagram.
That part of the diagram is displayed.

I'iiiffiliiiiliiiiiiiiiiili
Protsrt

Tistet nanoseconds

3). Click on the now checked menu Calibrate Time Scale.
Window

V Calibrate Time Scale
Analyse Peaks

A correlation method is used to find the time deviations from the default
calibration values.

,. . . Protondetectot t " ~

4) Click on Correct for Asymmetry to correct for asymmetry effects.
Accept the values using Done or ignore them using Cancel.

Coftect for

During point 3 you may enhance the correlation using another value of the time
window.2 Insert a new value of the time window and click on recalculate. The
correlation coefficient should be as close to 1 as possible and the gaussian used for the
correlation should fit into the data on the graph.

2 The width of the used Gaussian is proportional to the value of the time window.
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6. Tools for the Manipulation of the Graphs
Several tools are available for manipulating the diagrams. Some of them are common
to all graphs, others are only visible in some of the graphs. The menu Tools-2D gives
the user a possibility to change the appearance of the 2D-graphs and ToolsSD is the
corresponding menu for the 3D-graphs. Some analysis of the data such as background
subtraction and peak analyses is available in the Analyse menu and, finally, the normal
window options are included in the Window menu.

6.1. Tools for two-dimensional Graphs

Zoom is a one level zoom for enlargement of some
part of the graph.

Log/Lin is a toggle switch for logarithmic or linear
display of the data.

Display Options is used to re-bin the data and zoom to
a well-defined part of the graph.

Marker gives a vertical movable line.
Toolbar gives access to the Graphic Server options

Log/Lin
Display Options I

Show Marker
Show Toolbar

6.1.1. Zooming of 2-D Graphs

Do the zooming as follows
1) Click Zoom on the menu
2) Click on the left corner of the zoom area,
3) Click on the right corner of the zoom area.

A rectangle is shown after item 2. The zooming controls
only the abscissa values. The settings of the ordinate is
automatically done by the Graphic Server. A more exact setting
of the abscissa can be done using the menu Display Options.

Use the Reset Zoom menu to return to the full graph.
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6.1.2. Display Options for 2D Graphs

Several display options are available to the user. At the time of the first appearance of
the graph it is displayed according to the resolution in the data field. The option rehin
gives a representation with a number of data point summed together. This is the
traditional way to represent the data. Another possibility is to use the sliding mean. It is
a moving average. A number of data points are added together for each data point in
the original data field.

The part of the data field to be displayed can exactly be determined by the
values given to the minimum and maximum value.

Display Options

eart

keV ~~

Min o
20470

Width ho

&efeulj Energy \ Cbecfc < Carwet !

Set the Display Option, Min., Max., and Width. Use Check to make the values
consistent and Done to display the data using the new setting.

The spin buttons step the Min., Max., or Width values.

Display Options is the method to display the data. Default uses the channel
width defined by the graph

k.
r •«,&•?

...tfiypO41 SUB-NET SSSSSS SS!

Sliding Mean gives the mean value
of the data in the region defined by
Width. The mean value is shown for all
channels within the Min. and Max.
Values.

Rebin gives the fixed mean values
for the regions defined by Width. This is
the traditional way to display the data.

Default Energy gives values often
used for the neutron energy graph.
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6.1.3. A Marker

Reset Zoom
Log/Lin
Display Options

VShow Marker
Show Toolbar

II I
uncheck it.

Click Show Marker to
insert a movable marker. It gives
you some help to read the scale:

Remove the marker before
you continue with another
operation. Click on the menu to

6.1.4. The Toolbar for the Graphic Server

lit m NJ,

/ M1MU

The Graphic Server from Bits per Second is used for the display of all graphs.
Only a few options are included in the program. However, you may use the toolbar to
get access to other options. Most valuable are the print and copy options. You may
shape the output by including titles and more informative legends. Symbols and
"sticks" are other options to be used for special applications.

All options are available but use them with care. Some options need special
data areas to be loaded. As that is not done by the program they may give unexpected
results. More information is given in the Graphic Server Help File.
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6.2. Tools for three-dimensional Graphs

Zoom is a one level zoom for enlargement of some
parts of the graph.

Display Options is used to zoom to a well-defined
area and to increase the display resolution.

Some Views are available in the menu. Other views
can be created using the Graphic Server options.

Log/Lin is a toggle switch for logarithmic or linear
display of the data.

Show Toolbar gives access to the Graphic Server
options. It has the same functions and limitations as in the two dimensional graphs.

Flight View
Satelite View
Plane View

Log/Lin
Show Toolbar

6.2.1. Zooming of 3-D Graphs

The first graph presented is a plane view
containing the full 256*256 matrix. Use Zoom to
zoom into a suitable area.

1) Click on menu Zoom. The graph will be re-drawn to create "hot-spots".
2) Click on the lower left corner. A movable string will appear.
3) Click on the upper right corner. The graph will be zoomed.
A more exact setting can be done using the Display Options.

Estimated Bjss$aj« Time Js 4 seeaotfs

6.2.2. Display Options for 3-D Graphs

The Zoom option gives
only an approximate setting of
the zoomed area. Here is the tool
to do it more accurately. One
sets the corners of the part of the
256*256 matrix that is to be
displayed. One have also the
possibility to increase the number
of displayed elements. The
maximum number is 6000. A
slow computer will use a lot of
time to display 6000 points. An

approximate time of display is given as a guide. Note that the data points are
compressed during the display. Therefore the display may not always appear as you
have expected.
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6.2.3. Views for 3-D Graphs

The Graphic Server contains a very flexible 3D-presentation. Short-cuts to
three of these are given in the menu.

The Plane 3D View is presented to
the user as the first option. It is the most
suitable one for zooming although zooming
can be done in any of the views.

The flight view gives a view slightly from above and Satellite view directly from
the sky.

lililliliiiiiP

However, the user has the possibility
to use the Toolbar. The 3D-button in the
Graphic Server gives access to all types of

views.
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6.3. Tools for the Analysis of the Data

Calibrate Time Scale
Analyse Peaks

Add or Save Spectrum
Response Correction
Background

The analyse menu contains some routines for
the calibration and the investigation of the spectra. The
menu items are only visible, and applicable, for some
of the windows.

At this point the energy and the flight-time
probably are calibrated. However, here is a possibility
to re-calibrate them. Another useful tool to be used for

any graph is the Analyse Peaks. The energy distributions may be corrected for the
energy-dependent sensitivity using the Response Correction. Some graphs come with a
background correction. This can be analysed using Background.

Add or Save Spectrum is a tool to add the result from several shots for
enhanced statistical accuracy. Only graphs using the same number of sets and points as
defined by the graphic server can be added.

6.3.1. The Peak Analyses

1 Exit Options Copy
Values MKeV

Time interval

Peak a!

FWHM item width

FWIM from width

SHU. of Counts

Average channel

Average deviation

Standard deviation

fWHtt!nwr$Hf.«tev.

1 Skewness stct dev

j fotttosis

1 K«rtosis sfd dev

A< 614>

11
50

480

614.

14080.26

320.62

419.02

986.71

-.0664

.0989

.3664

.1977

B< 541>

13870

30

330

541.

13984.70

297.77

384.08

904.44

.0869

.1053

.0524

j .2106 |

The table resulting from an
analysis of the peaks is somewhat
different for different graphs. As an
example we use two time intervals
from the energy distributions of shot
41760.

Time Intervals are copied from
the legend of the graph.

Peak at gives the channel with
the highest intensity within the chosen
interval.

FWHM and FWTM are
calculated in the traditional way.
Starting at the maximum channel the
channel before the first channel, which
has an intensity of half or 1/10 of the
maximum channel, is used for the
calculation of the width. Note that
these values are not relevant for low
intensities.

Sum of Counts is the sum of the counts within the interval defined by the
zooming.

Average Channel is the mean energy of the counts.
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Average deviation is the average deviation from the mean energy.
Standard deviation is the value to be preferred if the interval properly covers

the peak.
FWHMfrom Std. dev. is the corresponding FWHM.
Skewness is the third moment of the distribution. It is negative if there is a tail

on the low side of the peak, zero if the peak is symmetric, and positive if there is a tail
on the high side of the peak.

Kurtosis is the fourth moment. It is theoretically negative for a flat distribution,
zero for a Gaussian, and positive for a distribution more peaked than a Gaussian. In
practice the zoom limits disturb it. For a Gaussian we get a negative value because the
wings are clipped.

The values may be displayed as Channel Units
| or the units defined by the graph.

A simple background correction is included.
The outermost channels are used for a straight line

JV Energy Units
Correct for background

defining the background.
You may copy the whole table or parts of it to the Clip-Board.

6.3.2. The Response Correction

The data are divided by the sensitivity to give the number of neutrons at the
foil per energy interval. The ordinate is expressed as kilo-neutrons.

Magnus gives the sensitivity as calculated by the Monte Carlo program written
by Magnus Hok,

Gammel uses the hydrogen scattering cross-section only.
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6.3.3. The Background Correction

Show Background
Show Foreground-Background

The flight time interval is divided into two halves. Both are evaluated in the
same way. It is assumed that the second half contains only background.

Foreground gives the evaluation of the first part, i.e. the total distribution.
Background is the evaluation of the second part, i.e. the background

distribution.
Foreground - Background is the resulting corrected distribution. That is the

one drawn when the window is created.

This is a simple background correction which works well as long as the total
count-rate of neutron detectors is lower than some MHz. At higher rates a more
sophisticated method must be used. Time shielding is one effect that should be
included at that time.

6.4. Windows

Tile Horizontal
Tile Vertical

The window menu contains the normal
windows functions. Note that more than one window
may contain the same data to be presented in different
ways.
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7. The Files used by Sort

Input file name extensions are .MEA for the A-branch and .MEB for the B-
branch. A routine in SNAP is used to convert the JPF files into formats suitable for
transport by FTP to the PC for evaluation using SORT.

The PARA program files .PAA and .PAB contain the parameters in ASCII
format. The same format and extensions are used here for the import and export of
parameters.

Spectra may be stored, added, and retrieved. The extensions follow a tag used
to identify the type of graph. The files have the following extensions:

Spectrum type Extension
Two dimensions

Amplitude vs. Time
Amplitude vs. Proton Detector
Flight-Time vs. Time
Flight-Time vs. Neutron Detector
Flight-Time vs. Branch
Neutron Energy vs. Time
Neutron Energy vs. Proton Detector
Neutron Energy vs. Branch
Geometric Factor vs. Time
Geometric Factor vs. Proton Detector
Geometric Factor vs. Branch

.ATI

.APR

.TTI

.TNE

.TBR

.NET

.NEP

.NEB

.GFT

.GFP

.GFB
Three dimensions

Amplitude and Flight-Time
Proton Energy and Flight-Time
Neutron Energy and Geometric Factor
Neutron Energy and Time

.A3T

.P3T

.N3G

.N3T
Time Calibrations

Check Time Calibration
Flight Time Calibration

.TRC

.CAT
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